Mac OS X Server
Installation Manual
Contents

1 Welcome to Mac OS X Server  5
   What’s Included With Mac OS X Server  5
      Apache Web Server Software  5
      WebObjects  5
      NetBoot Server Software  6
      Scalable File Services  6
      QuickTime Streaming Server Software  6
   System Requirements  6
   Steps for Installing Mac OS X Server Software  7

2 Formatting Your Hard Disk  9
   Partitioning a Hard Disk for Mac OS X Server  10

3 Installing Mac OS X Server  13
   Installing the Software  13
   After Installing Mac OS X Server  15
      Using the Setup Assistant  15
      About Starting Up  15
   Where to Find More Information  16

4 Installing WebObjects  17
   Installing WebObjects Deployments  17
      After Installation  18
      Upgrading Your License  18
   Installing Developer Tools  18
      System Requirements  18
5 Setting Up Your NetBoot Server  21
Planning Your Network  21
  Determining How Many Clients to Connect to the Server  21
  Gathering Information for the NetBoot Server Setup Assistant  22
  NetBoot Server Worksheet  27
Installing and Setting Up NetBoot Server Software  27
  If NetBoot Server Software Is Already Installed on Your Server  27
  If You Need to Install NetBoot Server Software  28
Setting Up Macintosh Manager  28
  Opening Macintosh Manager  29
Starting Up a NetBoot Client Computer  30
Installing Applications for NetBoot Clients  30
Getting More Help  31

6 Troubleshooting  33
Problems With Your Server  33
Problems With NetBoot Client Computers  35
Common Troubleshooting Tasks  36
  Making Sure the Hard Disk Is Working Properly  36
  Checking Server Processes  36
  Restarting the Server  37
  Halting Mac OS X Server and Restarting From the CD  37
  Using the System Disk Program to Select a Startup Disk  38
  Repairing Mac OS X Server Disks  38
Welcome to Mac OS X Server

Mac OS X Server combines the proven strength of UNIX® and the trademark ease-of-use of the Macintosh to create a powerful new server operating system. It delivers higher performance and greater reliability, along with compelling services tailored for the Internet, publishing, and education.

What’s Included With Mac OS X Server

Mac OS X Server is built on the same foundations that will power Mac OS X, providing system-wide protected memory and full preemptive multitasking. It also supports open standards such as 100% Pure Java and BSD 4.4. It is wrapped in a friendly desktop interface called Workspace Manager. For more information about the system, open the Help menu in Workspace Manager.

Mac OS X Server includes the following services, all of which can be easily enabled using Mac OS X Server’s Setup Assistant:

Apache Web Server Software

Mac OS X Server includes Apache, the world’s most popular Web server, which scales from small workgroups to an Internet site hosting multiple domains and handling millions of hits per day. The Mac OS X Server Setup Assistant allows you to set up a basic Apache server with a single click. This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org).

WebObjects

Apache also provides a conduit for WebObjects applications. Mac OS X Server includes a basic deployment license for Apple’s WebObjects application server, the industry’s leading technology for deploying network applications across corporate intranets or the World Wide Web. For this release, the full suite of WebObjects development tools are also bundled with the commercial version of Mac OS X Server.
**NetBoot Server Software**

NetBoot is a revolutionary new technology that makes it easy to set up and administer a network of Macintosh computers. NetBoot allows the computers on the network to run from a shared System Folder and use shared applications stored on a network server. NetBoot also provides users with secure access to the applications and personal files they need from any Macintosh computer on the network.

**Scalable File Services**

Mac OS X Server is capable of supporting thousands of open files and over a thousand concurrent users. Authorized users can access files from any AppleShare client over TCP/IP or AppleTalk. User and group information can be shared among multiple servers, and everything can be managed remotely using web-based remote administration tools.

**QuickTime Streaming Server Software**

Mac OS X Server also includes a special preview version of the QuickTime Streaming server. QuickTime Streaming allows you to deliver rich digital media over the Internet or intranets to any QuickTime-capable application. For information on how to obtain a compatible QuickTime client, visit http://www.apple.com/quicktime/.

**System Requirements**

To use Mac OS X Server you must have a desktop or minitower Power Macintosh G3 computer with

- at least 64 megabytes (MB) of random-access memory (RAM)
  
  To use a QuickTime Streaming server, a minimum of 256 MB of RAM is recommended; to use a single service at full capacity, a minimum of 128 MB is recommended. Using multiple services at the same time significantly increases RAM needs.

- a hard disk with at least 1 gigabyte (GB) of available storage space (also see the hard disk partitioning recommendations on page 10)

- built-in video or an Apple-supplied video card

**Important** For the latest information about supported and compatible systems, go to http://www.apple.com/support/
Steps for Installing Mac OS X Server Software

If you purchased a computer with Mac OS X Server software already on it, you don't need to install anything else to use the server.

To install Mac OS X Server software, follow these steps:

1. Decide how you're going to use the server.
   For example, will you use the server for QuickTime Streaming? for basic file sharing? as a NetBoot server? How you’ll use the computer determines how you format its disks.

2. Format the computer's hard disk(s) according to the recommendations and procedure in Chapter 2, “Formatting Your Hard Disk,” on page 9.


4. Use the Setup Assistant to configure your system.
   The Setup Assistant starts automatically at the end of the software installation process.

5. If you are going to install WebObjects or NetBoot server software, follow the instructions in Chapter 4, “Installing WebObjects,” on page 17 or Chapter 5, “Setting Up Your NetBoot Server,” on page 21.
   The NetBoot Setup Assistant starts automatically after you install the NetBoot server software.
CHAPTER 2

Formatting Your Hard Disk

Mac OS X Server supports three file system formats: Mac OS Standard (HFS), Mac OS Extended (HFS Plus), and Mac OS Server (UFS). Mac OS 8 cannot read UFS disks or files, but Mac OS X Server can read all three formats.

You can have multiple formats on the same disk by partitioning it (dividing it into sections) and selecting a different format for each partition. Mac OS X Server requires at least a 1 GB Mac OS Server partition. You can create up to eight Mac OS Extended partitions on the same disk, but you can only have one Mac OS Server partition per disk.

If your Mac OS X Server will share files with Mac OS 8 computers, or import data from Mac OS 8 clients for Apache Web services or QuickTime Streaming, you need at least one Mac OS Extended partition.

**Note:** Instead of creating partitions on the same disk, you can format entire disks (internal hard drives or external drives connected to one computer) in different formats.

If you purchased a computer with Mac OS X Server already installed, its hard disk is already partitioned. (See the computer manual for more information.) You don't need to continue with the instructions in this manual unless you want to change the way your hard disks are formatted and partitioned.
The following table suggests some of the partitioning options.

<table>
<thead>
<tr>
<th>To set up one of these services...</th>
<th>...format the hard disk with these partitions:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mac OS Server partition</td>
</tr>
<tr>
<td>A high-performance Apache Web server</td>
<td>Entire disk</td>
</tr>
<tr>
<td>A high-performance QuickTime Streaming server</td>
<td>Entire disk</td>
</tr>
<tr>
<td>An Apache Web server or QuickTime Streaming server that will share files with Mac OS clients</td>
<td>1 GB minimum</td>
</tr>
<tr>
<td>An Apple file services server</td>
<td>1 GB minimum</td>
</tr>
<tr>
<td>A NetBoot server</td>
<td>1 GB minimum</td>
</tr>
</tbody>
</table>

**Partitioning a Hard Disk for Mac OS X Server**

If the disk on which you’re going to install Mac OS X Server will also have at least one Mac OS Extended partition, you first create all the partitions in Mac OS Extended format. When you install Mac OS X Server, you select one of the partitions to be reformatted in Mac OS Server format.

If you are going to install Mac OS X Server on a disk with Mac OS Extended partitions, and you want the disk entirely formatted in Mac OS Server format, then follow the steps below to format the disk.

Use a Mac OS utility such as Drive Setup (provided on the Mac OS X Server CD, in the Utilities folder) to initialize your hard disk and create partitions. You can create up to eight Mac OS Extended partitions on a single disk. You can have only one Mac OS Server partition per disk.

**Warning** Partitioning a disk erases all the information on that disk. Before you partition a hard disk, back up any files you want to keep.

To partition a disk, follow these steps:

1. Insert the Mac OS X Server CD.
2. Restart your computer while holding down the C key.
This starts up the computer from the CD using Mac OS 8 (on the Mac OS Extended partition of the CD).

3 Locate and open the Drive Setup application (in the Utilities folder).

4 Open the Help menu and choose Drive Setup Help.

5 Follow the instructions in Drive Setup Help (see the “partitions” topics in the index) to create your Mac OS Extended partitions.

If the disk is going to be formatted entirely in Mac OS Server format, then choose one partition. Otherwise, create the number of partitions you need (all in Mac OS Extended format), and make at least one partition at least 1 GB for Mac OS X Server to be installed on.

Important If you are creating a NetBoot server, for fastest performance, don’t create more than two partitions on your hard disk.

6 Quit Drive Setup and proceed to Chapter 3 for instructions on installing Mac OS X Server.
Installing Mac OS X Server

Installing the Software

Note: If you are installing Mac OS X Server on an external hard disk, make sure the SCSI ID number of the disk is the number you plan to use after installation. If you change the disk's SCSI ID number after installation, you’ll need to use the System Disk application to reselect the startup device. See “Using the System Disk Program to Select a Startup Disk” on page 38 for details.

To install Mac OS X Server software, follow these steps:

1. Insert the Mac OS X Server CD in your computer’s CD-ROM drive.

2. Restart the computer while holding down the C key.
   Your computer starts up from the CD. Continue holding down the C key until you see the Welcome to Mac OS message.

3. If necessary, open the Mac OS X Server Install folder on the CD, then double-click the Install Mac OS X Server icon.

4. Select the language you want to use for the installation.
   Note: If you purchased the English version of the product, most services will be available only in English, even if you install the software using a different language.
A screen appears describing the steps in the installation process.

5 Click Continue to begin, then follow the onscreen instructions.

The Installer guides you through the steps necessary to install the software. To learn more about each step, click the Help button ( hỏi ) in the upper-right corner of the window.

**Important** Your computer restarts several times as a normal part of the installation process.

**Warning** Once installation begins, don’t click Quit or Stop. If you do, your hard disk (or the partition on which you’re installing the software) may be left in an unusable state and you’ll need to start the installation from the beginning.

If you cancel the installation process and then you can’t start up the computer, and the computer has a Mac OS partition available, try one of the following:

- Start up from the Mac OS partition by pressing the Option key while you press the Power key.
- Reset the parameter RAM by pressing the following keys while you press the Power key: Command-Option-P-R. Continue to press the keys until you hear the startup sound twice or see the computer attempt to restart twice. (Some monitors suppress the startup sound.)

If neither of these works, try starting up the computer from the Mac OS X Server CD (press the C key and the Power key).
After Installing Mac OS X Server

Using the Setup Assistant
The Setup Assistant helps you to configure your computer. The assistant asks you questions about yourself, your location, and the settings and services you want for your computer, and then configures your computer using your answers. You can use the Setup Assistant (in the Apple menu, in the Server Administration submenu) anytime you want to change the settings for your computer.

Important You must complete the Mac OS X Server Setup Assistant before you install NetBoot software.

Assigning Passwords
Mac OS X Server is a multi-user operating system; users must log in with a user name and password. When you use the Setup Assistant, you specify a user name and password for the root user (the Administrator), and you can create any number of local user accounts. If you select the Automatic Login option in the Setup Assistant, then every time the computer starts up, it automatically logs in to the account you specified, without asking for a password.

Tip: To temporarily turn off automatic login so you can log in with a different account, restart the computer while holding down the mouse button; then release the mouse button when the login window appears.

You can create additional user accounts with the Network Manager application, located in the Apple menu (in the Server Administration submenu). You must know the Administrator, or “root,” password to create accounts. For help, open the Help menu in Network Manager.

About Starting Up
After you install Mac OS X Server and log in, the computer starts up with the Workspace Manager active.

To start up the computer in Mac OS 8 (if it is installed on an internal drive), press the Option key as the computer starts up. Once the computer restarts using the Mac OS 8 volume, if you want to restart in Mac OS X Server, use the System Disk application. See “Using the System Disk Program to Select a Startup Disk” on page 38 for details.
Where to Find More Information

After you install Mac OS X Server, refer to these valuable sources of information about using your computer.

Onscreen Help

The Help menu is your main source of “how to” information about Mac OS X Server and its services. Many application programs also have onscreen help.

To view onscreen help, switch to the program you want to use, then look in the Help menu.

Tip: You can use the Find application (in the Apple menu) of Mac OS X Server to search for content in the onscreen help. The help files are stored in the /System/Documentation/Help folder.

Late-Breaking News

If you have questions about compatibility or want to see other late-breaking news about this software, refer to the Read Me documents and release notes in the /System/Documentation folder on your hard disk and on the Mac OS X Server CD.

Updates and News on the Internet

Updates to the documentation, additional documentation, tips, patches, and other updates are available on the Apple Support Web site, located at the following address: http://www.apple.com/support/
CHAPTER 4

Installing WebObjects

Mac OS X Server includes a limited deployment license for Apple's WebObjects application server, the leading technology for deploying network applications across corporate intranets or the World Wide Web. For this release, the commercial version of Mac OS X Server also includes the full suite of WebObjects development tools.

If you intend to deploy a WebObjects application, follow the instructions in the next section, “Installing WebObjects Deployments.” If you will be creating such applications, follow the instructions in “Installing Developer Tools” on page 18.

Installing WebObjects Deployments

To install WebObjects Deployments, follow these steps:

1. Start up your computer in Mac OS X Server and log in as the Administrator (“root”).
2. Insert the Developer CD into your computer’s CD-ROM drive.
3. If necessary, double-click the CD icon to open its main window.
4. Double-click the Mac_OS_X_Server folder.
5. Double-click the WebObjectsDeployment.mpkg icon.
6. In the Package Selection dialog box, click Install.
7. If the Installer asks for your serial number, enter it in the text field and click OK.
   The product serial number is on the CD envelope, in the format “A-999-AAA-999-AAA-999-999-999-999”.
8. When installation is complete, quit the Installer and restart your computer.
After Installation

The installer puts WebObjects CGI adaptors into the Apache CGI Bin directory and configures WebObjects to use them. WebObjects also includes a number of other HTTP server adaptors; to use one, see the online adaptor installation instructions in /System/Library/WebObjects/Adaptors/InstallationInstructions.html. These adaptors are provided in source form and can be customized; for instructions on rebuilding one of these WebObjects HTTP server adaptors, see /System/Developer/Examples/WebObjects/Source/Adaptors/BuildingInstructions.html.

Upgrading Your License

To apply a newly purchased deployment license to an existing development or deployment installation, you need only change the installed serial number using the WebObjects License Upgrader application (in the Apple menu, in the Server Administration submenu). Log in as the Administrator, open the license upgrader, and enter the new serial number (found on the CD envelope or obtained from Apple).

Installing Developer Tools

For this release of Mac OS X Server, the commercial version of the product includes the full suite of WebObjects tools for creating network applications. Other versions may include a more limited subset for creating Mac OS X Server applications. The standard Mac OS X Server Developer Tools package includes:

- InterfaceBuilder, for visual development of desktop and Java-client user interfaces
- ProjectBuilder, for managing and organizing your development projects, including code editing, compiling, and debugging in a variety of languages including Java™
- EOModeler, for visual entity-relationships modeling for databases, forward and reverse engineering of database schema, and integration of multiple data sources within a single model

In addition to the above, the full WebObjects Developer Tools package includes:

- WebObjectsBuilder, for visual application development
- Direct to Web, a ProjectBuilder wizard for rapidly creating Web front-ends to databases

System Requirements

To use WebObjects Developer you must have a Power Macintosh computer running Mac OS X Server. The computer should have:

- at least 64 MB of RAM
- at least 500 MB of available hard disk space
To install Developer Tools, follow these steps:

1. Start up your computer in Mac OS X Server and log in as the Administrator (“root”).
2. Insert the Developer CD into your computer’s CD-ROM drive.
3. If necessary, double-click the CD icon to open its main window.
4. Double-click the Mac_OS_X_Server folder.
5. If you have a WebObjects Developer CD, double-click the WebObjectsDeveloper.mpkg file.
   
   If you have a Mac OS X Server Developer CD, double-click the MacOSXServerDeveloper.mpkg file.
6. In the Package Selection dialog box, click Install.
   
   For each package, the Installer checks for existing files on your disk and then installs the necessary package files.

   **Note:** If you want to exclude a component, deselect it before clicking Install. To develop WebObjects applications, you must install, at least, these packages: Developer Tools, Developer Libraries, WebObjects Deployment, and WebObjects Developer.

7. If the Installer asks for your serial number, enter it in the text field and click OK.
   
   The product serial number is on the CD envelope, in the format “A-999-AAA-999-AAA-999-AAA-999-AAA-999”. 
Setting Up Your NetBoot Server

You need to complete the following steps to set up your NetBoot server.

1. Gather information for the NetBoot Server Setup Assistant. Read the next section, “Planning Your Network.” You can use the NetBoot Server Worksheet, provided in this chapter to organize the information you need.

2. Install and set up the software. Read the section “Installing and Setting Up NetBoot Server Software” on page 27.

3. Set up Macintosh Manager. Follow the instructions in “Setting Up Macintosh Manager” on page 28.


5. Install software for your users. Read “Installing Applications for NetBoot Clients” on page 30 for information about the special procedures you need to follow.

Planning Your Network

As you plan your network, you’ll need to gather information that you’ll use when you set up the network. You can write down this information on the NetBoot Server Worksheet, on page 27.

Determining How Many Clients to Connect to the Server

The number of NetBoot client computers you can connect to your server depends on how your server is configured as well as a number of other factors. A NetBoot server that has this configuration can easily support 25 NetBoot client computers:

- Macintosh G3 computer with a 400 MHz processor
- 256 MB of random-access memory
- Two 9 GB hard disks
- Four-port, 100Base-T Ethernet card
If you want to use a server that has a different configuration, or you want to support more than 25 client computers, consider these factors:

- **Ethernet speed**—For optimum performance, the use of 100Base-T connections for both clients and server is highly recommended.

- **Hard disk capacity and number of NetBoot client computers**—The NetBoot server requires a minimum amount of hard disk space for each client connected to it. The amount of space depends on the size and configuration of the system image.

- **Hard disk capacity and number of users**—Each user needs storage space on a server for documents and for his or her preferences. If you have a large number of users, consider adding a separate file server to your network to store user documents. By default, users’ documents and preferences are stored on the NetBoot server, but any AppleShare server can store this information. (You set up where documents and preferences are stored using Macintosh Manager.)

- **Location of server and client**—The startup server program can only support NetBoot client computers on the same subnet, and only one NetBoot server can run on a subnet. A NetBoot client computer can’t start up using a server on a different subnet.

- **Number of Ethernet ports on the server**—Distributing NetBoot clients over multiple Ethernet ports on your server offers a performance advantage. You can add ports by adding Ethernet cards, or by using several ports on a multiport Ethernet card. Each port must serve a distinct segment.

### Gathering Information for the NetBoot Server Setup Assistant

If you don’t have the information described in the following sections, you need to get it from your organization’s network administrator. When you get the information, write it on the NetBoot Server Worksheet, on page 27. You need this information for each Ethernet port you plan to use for NetBoot clients.

If you purchased your software with a server, the server has at least five Ethernet ports. One port is the built-in Ethernet port that comes with your server. Other ports are on Ethernet cards installed in your server. What you have depends on the configuration of your server. If the built-in port is a 10Base-T Ethernet port, do not use it to connect NetBoot clients. The connection from the server to the NetBoot clients should be 100Base-T Ethernet.

### Port Internet Addresses

*Each Ethernet port you use for NetBoot clients needs an IP address and a subnet mask.* You need to use a subnet mask that restricts local traffic to the IP addresses of the NetBoot clients connected to this port. Your organization’s network administrator should provide you with the appropriate subnet mask for each port.
**NetBoot Client Internet Addresses**

You need to supply one or more ranges of IP addresses for the NetBoot clients connected to each Ethernet port. You need one IP address per computer, but it's best if you allocate a few extra to accommodate expansion.

**IP Routing Information**

The IP routing information you need to provide to the NetBoot Server Setup Assistant depends on the configuration of your network.

*NetBoot clients are connected directly to the router.*

The server is a peer of NetBoot clients on a single subnet—each is connected directly to the router. If this is your configuration, select Peer in the IP Routing Configuration panel of the NetBoot Server Setup Assistant. For “Router IP address” enter the IP address of the router.
NetBoot clients are connected directly to the router.

This configuration is similar to the previous one, except there are two NetBoot client subnets. Each subnet is connected to a different port on the router and a different port on the server. If this is your configuration, select Peer in the IP Routing Configuration panel of the NetBoot Server Setup Assistant. For “Router IP address” enter the IP address for the router port you connect to that subnet.
In this configuration, the server acts as a router to one or more NetBoot client subnets. If this is your configuration, select Gateway in the IP Routing Configuration panel of the NetBoot Server Setup Assistant. You do not need to provide a router address.

**Note:** For clients to have access to the Internet, routing tables need to be updated with the server acting as a gateway for the client subnet. You need to make a separate entry for each client subnet. You use software that came with your router to make changes to the routing table.
No router—NetBoot clients are isolated from the Internet.

If this is your configuration, select Gateway in the IP Routing Configuration panel of the NetBoot Server Setup Assistant. You don’t need to provide a router IP address.

**AppleTalk Addressing**

If the NetBoot server is a gateway and you want to use AppleTalk zones, you must provide this information so it can act as a seed router:

- a range of AppleTalk network numbers
- AppleTalk zone names (You can specify which zone is a home zone if you’d like.)

You can get this information from the system administrator who manages AppleTalk zones for your organization.
NetBoot Server Worksheet

Information Needed for Each Ethernet Port

The number of ports you have depends on the configuration of your server.

<table>
<thead>
<tr>
<th>Network Information</th>
<th>Built-in Ethernet port</th>
<th>Ethernet card port 1</th>
<th>Ethernet card port 2</th>
<th>Ethernet card port 3</th>
<th>Ethernet card port 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subnet mask</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address ranges</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>for NetBoot clients</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Router address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(if needed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AppleTalk zone names</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(if needed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AppleTalk network numbers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(if needed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Installing and Setting Up NetBoot Server Software

If you have not read the section “Planning Your Network” on page 21 and filled out the NetBoot Server Worksheet, above, you should do so now before you proceed. You need to have this information handy when you use the NetBoot Server Setup Assistant.

If NetBoot Server Software Is Already Installed on Your Server

If you purchased your software with a server, the NetBoot server software is already installed on your server. You need only to set up the software by using the NetBoot Server Setup Assistant.

If the NetBoot Server Setup Assistant isn’t already open, follow these steps to open it:

1. Log in to the Mac OS X Server with the user name “Administrator.”
   Use the Administrator password you set up when you used the Mac OS X Server Setup Assistant.

2. Double-click Assistant.app in the /System/Administration directory.

3. When the Assistants window opens, double-click NetBoot Server Setup Assistant.
4 Follow the onscreen instructions.

The Assistant guides you through the steps necessary to set up the software. To learn more about each step, click the Tell Me More button in the window.

If you need to change any setup information in the future, you can use the NetBoot Server Setup Assistant to make changes.

**If You Need to Install NetBoot Server Software**

If you purchased your software as a standalone package without hardware, you need to install NetBoot server software. NetBoot server software is on a separate CD that comes as part of your software package. You must install NetBoot server software on a computer that already has the Mac OS X Server software installed and set up. (See Chapter 3, “Installing Mac OS X Server,” on page 13 for instructions on installing Mac OS X Server.)

To install NetBoot server software, follow these steps:

1 Insert the NetBoot Server CD in your computer’s CD-ROM drive.
2 Double-click the NetBoot Server CD icon.
3 Double-click NetBootInstaller.assistant.
4 Follow the onscreen instructions.

The Installer guides you through the steps necessary to install the software.

5 Restart the computer when installation is complete.
6 Open the NetBoot Server Setup Assistant.

If the NetBoot Server Setup Assistant doesn’t open automatically, open it by double-clicking Assistant.app in the /System/Administration directory. When the Assistants window opens, double-click NetBoot Server Setup Assistant.

7 Follow the onscreen instructions.

The Assistant guides you through the steps necessary to set up the software. To learn more about each step, click the Tell Me More button in the window.

If you need to change any setup information in the future, you can use the NetBoot Server Setup Assistant to make changes.

**Setting Up Macintosh Manager**

Macintosh Manager is the software you use to

- add and manage users
- add and manage workgroups
- set up and manage groups of workstations
Setting Up Your NetBoot Server

- control users’ access to computers
- set up how users’ preferences are saved
- set up access to printers, file servers, and other network resources
- set security options, such as minimum password length

The first time you use Macintosh Manager, you need to set up global, workstation, and server options, and then you need to create user accounts and workgroups. The options you set depend on the purpose of your network, the experience level of your users, and the security needs of your organization.

**Opening Macintosh Manager**

To use Macintosh Manager for the first time, do this:

1. Turn on a computer that’s connected to the network.
   Do not try to use Macintosh Manager from the Mac OS X Server. You must use a Mac OS computer that’s connected to the network. Be sure to start up the computer from its own hard disk.

2. Use the Chooser to log in to the NetBoot server.
   You can log in as “Administrator” using the password you set up for the Administrator account on Mac OS X Server. You can also log in to the NetBoot server with any AppleShare user name and password with the appropriate privileges.

3. Double-click the Admin folder.

4. Double-click the Macintosh Manager icon.
   **Note:** If you want to use Macintosh Manager from a local hard disk, copy the Admin folder from the server to the local hard disk of your Mac OS computer. Then double-click the Macintosh Manager icon.

5. Type the same user name and password you entered for step 2.

6. Set up global, workstation, and server options. Then create users and workgroups.
   For information about the options you can set, see the “Setting Macintosh Manager Options” topic in Macintosh Manager Help. To open Macintosh Manager Help, choose it from the Help menu.

7. Quit Macintosh Manager.
   Quitting activates the server and enables the user accounts you set up.
**Starting Up a NetBoot Client Computer**

Any Mac OS computer that is capable of starting up from a NetBoot server can be a NetBoot client computer.

If your computer’s firmware needs to be updated, update it now. For more information see the iMac Firmware Updater Read Me file located in the Admin folder on the NetBoot server volume.

To start up a NetBoot client computer, follow these steps:

1. Connect the client computer to the network.
2. Hold down the N key while you turn on the client computer.
   This forces the computer to look for a NetBoot server. It may take a few moments for the client computer to find the server and start up. If the computer doesn't start up after a few moments, see Chapter 6, “Troubleshooting,” on page 33.
   Once the computer has started up, you see two mounted volumes, one named Applications and the other named Macintosh HD (unless you renamed the startup volume when you set up Macintosh Manager).
3. Open the Startup Disk control panel and choose Macintosh HD.
   The next time you start up the computer, you do not need to press the N key. Once a computer has started up from the NetBoot server, it will always start up from the NetBoot server unless there is a problem (such as the server is turned off) or you change the startup disk in the Startup Disk control panel.

**Installing Applications for NetBoot Clients**

The Applications and Macintosh HD volumes that you see when you log in to a NetBoot client computer are read-only volumes. You must use NetBoot Desktop Admin software from a NetBoot client computer before you can make any changes, such as installing an application for your users.

When you finish installing applications you need to use NetBoot Desktop Admin software again to make the volumes read-only and available to other users. If you don’t use NetBoot Desktop Admin software after you’ve installed applications, it’s possible for unauthorized changes to be made, and the changes you made won't take effect.

Instructions for using NetBoot Desktop Admin software are in the NetBoot Desktop Admin Read Me file located in the Admin folder on NetBoot server volume.

To access the NetBoot Desktop Admin Read Me file, follow these steps:

1. On a Macintosh computer, use the Chooser to log in to the NetBoot server.
You must log in to the volume with the user name “Administrator” and the Administrator password you set up for Mac OS X Server.

2 Double-click the Admin folder icon.

3 Double-click the NetBoot Desktop Admin folder, then double-click the NetBoot Desktop Admin Read Me file.

**Getting More Help**

You can find additional help for setting up and using your NetBoot server in these locations:

- *Macintosh Manager Help*—Provides instructions on how to manage users and workgroups, set up workstation groups, make changes to global options, generate reports about server activity, and solve problems. You open Macintosh Manager Help by opening Macintosh Manager, and then choosing Macintosh Manager Help from the Help menu.

- *Mac OS X Server Help and Mac OS X Server Administration Help*—Provide information on managing Mac OS X Server, instructions for adding Ethernet ports and naming hard disks, tips for improving network performance, and information about using Mac OS X Server.

- *This manual*—See Chapter 6, “Troubleshooting,” on page 33 for information on solving problems related to installation and setup, or if your server crashes.

Troubleshooting

This chapter describes some common problems and solutions. Also refer to the troubleshooting information that came with the computer.

Problems With Your Server

The computer begins to start up, then won’t respond.

Mac OS X Server may be looking for a NetInfo server.
1 Disconnect the computer’s Ethernet connection.
2 When asked if you want to continue in non-network mode, enter Y.
3 Log in as Administrator.
4 Open the Apple menu and choose Computer Settings, then choose Network.
5 In the NetInfo panel, make sure “Connect to parent NetInfo server at startup” is not selected.

The monitor screen is black.

Try these solutions:

■ Press any key. (The computer automatically dims the display when left idle; you press a key to reset the display. You set the dimming interval in Monitor Preferences.)
■ Make sure the monitor is properly connected and adjusted. See the manual that came with your hardware for more information.
■ Make sure the computer has a supported video card. Shut down your computer by halting Mac OS X Server, then remove the video card. See “Halting Mac OS X Server and Restarting From the CD” on page 37. See “System Requirements” on page 6 for information about supported video cards.
Make sure the resolution in Monitor Preferences is set to a monitor resolution supported by your monitor. Shut down your computer by halting Mac OS X Server, then restart the computer using the Mac OS X Server CD. This will reset your monitor. Then use the System Disk application to select your Mac OS X Server hard disk as the startup disk, and restart your computer. See “Halting Mac OS X Server and Restarting From the CD” on page 37 and “Using the System Disk Program to Select a Startup Disk” on page 38.

**You can’t restart or shut down the computer.**

**Try these solutions:**

- Log in as Administrator, open the Apple menu and choose Preferences, and then choose Login Window. If the Power Off setting is checked, remove the check.
- Make sure there is enough space available on the startup disk to save the information necessary to shut down the computer. Delete files you no longer need. (Don’t delete any System files.)

**You can’t log in to Mac OS X Server.**

**Try these solutions:**

- Make sure you are entering your password correctly, using the same capitalization and punctuation that you originally used. If you still can’t log in, log in as Administrator and reset the password for your user account using Network Manager (open the Apple menu and choose Server Administration, then choose Network Manager).
- If you are using automatic login, temporarily bypass it by holding down the mouse button when you start up your computer. If you want to turn off automatic login, log in as the Administrator, then open the Setup Assistant (open the Apple menu and choose Server Administration, then choose Assistant) and turn off the Automatic Login option.

**Services don’t seem to be working.**

**Try these solutions:**

- Make sure the server is turned on.
- Check that one end of the Ethernet cable is plugged into the Ethernet port on the computer and the other end is plugged into a working Ethernet connector.
- Make sure the hard disk is working properly. See “Making Sure the Hard Disk Is Working Properly” on page 36.
- Check AppleTalk and TCP/IP configurations. See if the system can access AppleTalk devices or IP services on the network.
- Make sure the appropriate server processes are running. See “Checking Server Processes” on page 36.
- Restart the server. See “Restarting the Server” on page 37.
- Use ProcessViewer to see what’s working. See “Checking Server Processes” on page 36.
If you’ve exhausted all solutions, you may need to reinstall Mac OS X Server or NetBoot server software. If you reinstall server software you will lose documents and data. If you have backed up your server, you can restore the data you backed up.

**Problems With NetBoot Client Computers**

*A NetBoot client computer won’t start up.*

*Try these solutions:*  
- Sometimes a computer may not start up immediately because other computers are putting a heavy demand on the network. Wait a few minutes and try starting up again.  
- Make sure that all the cables are properly connected, and that the computer and server are getting power. See the troubleshooting information that came with the client computer for more information.  
- Check that one end of the Ethernet cable is plugged into the Ethernet port on the computer and the other end is plugged into a working Ethernet connector.  
- Make sure the startup server program is running. If other computers can start up from the server, the server program is running. If other computers cannot start up, see “Checking Server Processes” on page 36.  
- Make sure you haven’t exceeded the number of IP addresses assigned to your network. You check the IP address by logging in to the server and opening the Network Preferences panel.  
- If you installed memory or an expansion card in the client computer, make sure it is installed properly.  
- If you are using more than one Ethernet card, or you are using more than one port on a multiport Ethernet card, check to see if other computers using the same card or port can start up. If they can’t, check to be sure the Ethernet port you set up on the server is the same port the client computer is connected to. It’s easy to mistake Ethernet port 1 for Ethernet port 4 on a multiport card.  
- If the computer has a local hard disk with a System Folder on it, disconnect the Ethernet cable and try to start up the computer from the local hard disk. Then reconnect the Ethernet cable and try to start up the computer from the network.

**On a NetBoot client, you see the Mac OS desktop but the log-in screen doesn’t appear.**

Make sure Network is selected as the startup disk in the Startup Disk control panel (for network-startup computers).
A user can't log in to a NetBoot client.

Try these solutions:

- Check to see if the user can log in to other computers. If the user can log in to other computers, then the computer the user can't log in to may be connected to a Macintosh Management server the user does not have an account on. If there is more than one Macintosh Management server, make sure the user has selected a server on which he or she has an account.
- Open Macintosh Manager and make sure the user is a member of at least one workgroup.
- Open Macintosh Manager and reset the user's password.

Common Troubleshooting Tasks

Making Sure the Hard Disk Is Working Properly

You use the fsck command to repair corrupted or damaged hard disks in Mac OS X Server format. See “Repairing Mac OS X Server Disks” on page 38.

You use Disk First Aid to verify and repair a hard disk in Mac OS Extended format. The volumes you use to store NetBoot users' documents use Mac OS Extended format.

Note: Some volumes can be verified but not repaired, such as the volume the Disk First Aid application is stored on, a write-protected disk, or a disk that has open files. On your NetBoot server, the Disk First Aid application is located on a volume formatted in Mac OS X Server, and Disk First Aid does not verify or repair this type of volume.

To verify or repair a hard disk:

1. Log in to the server as the Administrator (“root”).
2. Open the Server Administration menu (in the Apple menu) and choose Disk First Aid.
3. Click the volume you want to verify or repair, then click Verify or Repair.
   You verify a hard disk first. If problems are found, then you can repair the disk.
   You can select more than one volume by pressing the Shift key while clicking a volume.

Checking Server Processes

To check server processes, follow these steps:

1. Log in to the server as the Administrator.
2. Open the Apple menu and choose Server Administration, then choose ProcessViewer.
**Restarting the Server**

**Warning** This method of stopping Mac OS X Server may result in data loss or disk corruption. It should only be used as a last resort. If possible, quit all applications and processes before following these instructions. Make sure there are no users logged in to the server before you restart the server.

1. If you can, save any open documents before restarting.
2. If you can, choose Log Out from the File menu, then click Restart.
3. If you can't log out or choose Restart, force a restart by holding down the Control and Power keys while you press the R key.
4. If the computer still doesn't restart, hold down the `⌘` and Control keys while you press the Power key.
5. If the server still doesn't restart, turn off the server using the power switch. If this doesn't work, or if your server doesn't have a power switch, unplug your server.
6. Wait at least 30 seconds, then reconnect the power plug (if necessary) and turn your server on again by pressing the Power key on the keyboard.
7. Use the `fsck` command (see “Repairing Mac OS X Server Disks” on page 38) to check the root file system disk.

**Halting Mac OS X Server and Restarting From the CD**

**Warning** This method of stopping Mac OS X Server may result in data loss or disk corruption. If possible, quit all applications and processes before following these instructions.

1. Put the Mac OS X Server CD in the CD-ROM drive’s tray, but do not close the tray.
2. Press Control-Power, then press the H key.
   After a moment, your computer turns off.
3. Gently close the CD-ROM drive.
4. Turn on the computer, then hold down the C key.
   Continue holding the C key until you see the Welcome to Mac OS message.
5. Use the `fsck` command (see “Repairing Mac OS X Server Disks” on page 38) to check the root file system disk.
Using the System Disk Program to Select a Startup Disk

System Disk is a Mac OS program that allows you to select which hard disk your computer will start up from. You can’t use the Mac OS Startup Disk control panel to select a Mac OS X Server disk as the startup disk.

To make a Mac OS X Server disk the startup disk, follow these steps:

1. Open the System Disk application.
The program is provided on the Mac OS X Server CD.
2. In the list of devices, select your Mac OS X Server hard disk.
3. Click Save and restart the computer.

Repairing Mac OS X Server Disks

You use the fsck command to repair corrupted or damaged hard disks (in Mac OS Server format). Normally this command runs automatically, but in some circumstances you need to run it manually.

1. Restart the computer, then hold down the S key until your screen displays several scrolling messages.

This starts up your computer in single user mode, which allows access to the command line.

2. At the # prompt, enter `fsck -y` and press Return.

The fsck program checks and repairs your hard disk. If you see an error message, enter the command again. You may have to do this a few times to repair all the damage. Recovered files found during this process are put in a top-level directory called “lost + found,” which is visible when you log in as Administrator.

The system cleans up temporary files (for example, those in the /tmp and /var/tmp directories) during restart; this is often sufficient for the computer to start up.

You can continue to clean up the disk by deleting excess data.

- To delete files to free up available space on your hard disk, enter `mount -uw /` then use the `rm` command (`rm filename`) to delete files you are sure you no longer need.
- To see a list of files, enter `ls`.
- To change directories, enter `cd directory`, where `directory` is the name of the directory you want to change to. You must enter the name of the directory exactly as shown on your screen.
- To get file size information, enter `ls -l`.

3. When you’re finished, enter `exit` to continue starting up Mac OS X Server.
Acknowledgements

Portions of the Apple software may utilize the following copyrighted material, the use of which is hereby acknowledged.

Adobe Systems
ITC Bookman, ITC Avant Garde Gothic, and ITC Zapf Chancery are registered trademarks of International Typeface Corporation.
Helvetica, Palatino, and Times are trademarks of Linotype AG and/or its subsidiaries.

Alice Group
Copyright © 1993 Allen K. Briggs, Chris P. Caputo, Michael L. Finch, Bradley A. Grantham, and Lawrence A. Kesteloot. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgement: This product includes software developed by the Alice Group. 4. The names of the Alice Group or any of its members may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE ALICE GROUP "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ALICE GROUP BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Apache Group
Copyright © 1995-1998 The Apache Group. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org/).” 4. The names “Apache Server” and “Apache Group” must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called “Apache” nor may “Apache” appear in their names without prior written permission of the Apache Group. 6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org/).”

THIS SOFTWARE IS PROVIDED BY THE APACHE GROUP "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE GROUP OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Acknowledgements

AT&T
The author of this software is David M. Gay. Copyright © 1991 by AT&T.
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

Carnegie-Mellon University
Copyright © 1991 Carnegie Mellon University. All Rights Reserved.
Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided that both the copyright notice and this permission notice appear in all copies of the software, derivative works or modified versions, and any portions thereof, and that both notices appear in supporting documentation.
CARNEGIE MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE. Carnegie Mellon requests users of this software to return to Software.Distribution@CS.CMU.EDU; or Software Distribution Coordinator, School of Computer Science, Carnegie Mellon University, Pittsburgh PA 15213-3890; any improvements or extensions that they make and grant Carnegie Mellon the rights to redistribute these changes.

Ian F. Darwin
Copyright © 1987 Ian F. Darwin. Written by Ian F. Darwin.
This software is not subject to any license of the American Telephone and Telegraph Company or of the Regents of the University of California. Permission is granted to anyone to use this software for any purpose on any computer system, and to alter it and redistribute it freely, subject to the following restrictions: 1. The author is not responsible for the consequences of use of this software, no matter how awful, even if they arise from flaws in it.
2. The origin of this software must not be misrepresented, either by explicit claim or by omission. Since few users ever read sources, credits must appear in the documentation. 3. Altered versions must be plainly marked as such, and must not be misrepresented as being the original software. Since few users ever read sources, credits must appear in the documentation. 4. This notice may not be removed or altered.

Digital Equipment Corporation
Portions Copyright © 1993 by Digital Equipment Corporation.
Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies, and that the name of Digital Equipment Corporation not be used in advertising or publicity pertaining to distribution of the document or software without specific, written prior permission.
THE SOFTWARE IS PROVIDED "AS IS" AND DIGITAL EQUIPMENT CORPORATION DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL DIGITAL EQUIPMENT CORPORATION BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

FreeBSD
This product contains software provided by FreeBSD, Inc. and its contributors.

Free Software Foundation
Copyright © 1988-1998 Free Software Foundation, Inc.
Parts of this product include certain software owned by the Free Software Foundation ("FSF software") and provided under the terms of the GNU General Public License; you can redistribute FSF software and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation. The FSF
software is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.

You may obtain a complete machine-readable copy of the source code for the FSF software under the terms of the FSF’s General Public License, without charge except for the cost of media, shipping, and handling, upon written request to Apple. A copy of the FSF’s General Public License is included with this product.

IBM Corporation
Copyright © 1987 IBM Corporation. All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of IBM not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.

IBM DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL IBM BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Ing. C. Olivetti & C. S.p.A.
Copyright © 1988, 1989 Ing. C. Olivetti & C. S.p.A. All rights reserved. Copyright © 1988, 1989 by Olivetti Advanced Technology Center, Inc., Cupertino, California. All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appears in all copies and that both the copyright notice and this permission notice appear in supporting documentation, and that the name of Olivetti not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.

OLIVETTI DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL OLIVETTI BE LIABLE FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN ACTION OF CONTRACT, NEGLIGENCE, OR OTHER TORTIOUS ACTION, ARISING OUR OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Lance Kurisaki
Copyright © 1996, 1997 Lance Kurisaki. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgement: This product includes software developed by Lance Kurisaki. 4. The name of the other may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY LANCE KURISAKI "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL LANCE KURISAKI BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Massachusetts Institute of Technology
Copyright © 1996 by the Massachusetts Institute of Technology. All rights reserved.
Export of this software from the United States of America may require a specific license from the United States Government. It is the responsibility of any person or organization contemplating export to obtain such a license before exporting. WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of M.I.T. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

THIS SOFTWARE IS PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Individual source code files are copyright MIT, Cygnus Support, OpenVision, Oracle, Sun Soft, and others. Project Athena, Athena, Athena MUSE, Discuss, Hesiod, Kerberos, Moira, and Zephyr are trademarks of the Massachusetts Institute of Technology (MIT). No commercial use of these trademarks may be made without prior written permission of MIT. “Commercial use” means use of a name in a product or other for-profit manner. It does NOT prevent a commercial firm from referring to the MIT trademarks in order to convey information (although in doing so, recognition of their trademark status should be given).

David L. Mills

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appears in all copies and that both the copyright notice and this permission notice appear in supporting documentation, and that the name University of Delaware not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. The University of Delaware makes no representations about the suitability this software for any purpose. It is provided “as is” without express or implied warranty.

NetBSD
This product contains software provided by The NetBSD Foundation, Inc. and its contributors.

Mark Nudelman

Tim Olson

This software is distributed absolutely without warranty. You are free to use and modify the software as you wish. You are also free to distribute the software as long as you retain the above notice, and you make clear what your modifications were. Send comments and bug reports to tim@apple.com

OpenBSD
This product contains software provided by OpenBSD and its contributors.


Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appears in all copies and that both the copyright notice and this permission notice appear in supporting documentation, and that the name of (“OSF”) or Open Software Foundation not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.

OSF DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL OSF BE LIABLE FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN ACTION OF CONTRACT, NEGLIGENCE, OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
OpenVision Technologies


WARNING: Retrieving the OpenVision Kerberos Administration system source code, as described below, indicates your acceptance of the following terms. If you do not agree to the following terms, do not retrieve the OpenVision Kerberos administration system.

You may freely use and distribute the Source Code and Object Code compiled from it, with or without modification, but this Source Code is provided to you “AS IS” EXCLUSIVE OF ANY WARRANTY, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR ANY OTHER WARRANTY, WHETHER EXPRESS OR IMPLIED. IN NO EVENT WILL OPENVISION HAVE ANY LIABILITY FOR ANY LOST PROFITS, LOSS OF DATA OR COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, OR FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT, INCLUDING, WITHOUT LIMITATION, THOSE RESULTING FROM THE USE OF THE SOURCE CODE, OR THE FAILURE OF THE SOURCE CODE TO PERFORM, OR FOR ANY OTHER REASON.

OpenVision retains all copyrights in the donated Source Code. OpenVision also retains copyright to derivative works of the Source Code, whether created by OpenVision or by a third party. The OpenVision copyright notice must be preserved if derivative works are made based on the donated Source Code.

Sun Microsystems

Copyright © 1987 by Sun Microsystems, Inc. Sun RPC is a product of Sun Microsystems, Inc. and is provided for unrestricted use provided that this legend is included on all tape media and as a part of the software program in whole or part. Users may copy or modify Sun RPC without charge, but are not authorized to license or distribute it to anyone else except as part of a product or program developed by the user or with the express written consent of Sun Microsystems, Inc. Sun RPC is provided with no support and without any obligation on the part of Sun Microsystems, Inc. to assist in its use, correction, modification or enhancement.

SUN RPC IS PROVIDED AS IS WITH NO WARRANTIES OF ANY KIND INCLUDING THE WARRANTIES OF DESIGN, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, OR ARISING FROM A COURSE OF DEALING, USAGE OR TRADE PRACTICE. SUN MICROSYSTEMS, INC. SHALL HAVE NO LIABILITY WITH RESPECT TO THE INFRINGEMENT OF COPYRIGHTS, TRADE SECRETS OR ANY PATENTS BY SUN RPC OR ANY PART THEREOF.

In no event will Sun Microsystems, Inc. be liable for any lost revenue or profits or other special, indirect and consequential damages, even if Sun has been advised of the possibility of such damages. Sun Microsystems, Inc.

Copyright © 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business. Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is preserved.

Avadis Tevanian, Jr

Copyright © 1986, Avadis Tevanian, Jr.

University of California, et. al

This product includes software developed by the University of California, Berkeley, and its contributors.

This code is derived from software contributed to Berkeley by Adam S. Moskowitz of Menlo Consulting; Adam de Boor; Asa Romberger; Atsushi Murai (amurai@spec.co.jp); Barry Brachman; Bob Toen; Brian Hirt.; Case Larsen; Chris Newcomb; Chris Torek; Cimarron D. Taylor of the University of California, Berkeley; Darren F. Provine; Dave Taylor; of Intuitive Systems; Dave Yost; David Barto at Celerity Computer Corp.; David C. Elliott, of MIPS Computer Systems; David Goodenough; David Hitz of Auspex Systems, Inc.; Diomidis Spinellis of Imperial College, University of London; Donna Seeley at Berkeley Software Design, Inc.; Eamonn McManus of Trinity College Dublin; Ed James; Edward Sze-Tyan Wang; Edward Wang at The University of California, Berkeley; Guy Harris at Network Appliance Corp.; Henry Spencer of the University of Toronto; Herb Hasler and Rick Macklem at The University of Guelph; James A. Woods; James W. Williams of the University of Maryland and NASA Goddard Space Flight Center; Jan-Simon Pendry; Jef Poskanzer and Craig Leres of the Lawrence Berkeley Laboratory; Jerry Berkman; Jim Gillogly at The Rand Corporation; Jim R. Oldroyd at The Instruction Set and Keith Gabryelski at Commodore Business Machines; John B. Roll Jr.; Joseph Orost; Keith Muller of the University of California, San Diego and Lance Visser of Convex Computer Corporation; Ken Arnold; Ken Smith of The State University of New York at Buffalo; Kenneth Alquist; Kevin Fall; Kevin Ruddy; Kim Lektzaman; Landon Curt Noll; Marciano Fitarque; Michael Fischbein; Michael Rendell of the Memorial University of Newfoundland; Michihiro Hikada; Mike Hibler; Mike Munro; Mike Olson; Muffy Barrioc; Ozan Yigit at York University; Pace Willisson (pace@blitz.com); Ralph Campbell; Rich $alz of BBN Inc.; Rick Adams; Rick Macklem at The University of Guelph; Robert Corbett; Robert Elz at The University of Melbourne; Robert Paul Corbett; Spencer Thomas; Stephen Deering of Stanford University; Steve Hayman of the Indiana University Computer Science Department; Sun Microsystems, Inc.; Symmetric Computer Systems; Timothy C. Stoehr; Tony Nardo of the Johns Hopkins University/Applied Physics Lab; and the Systems Programming Group of the University of Utah Computer Science Department.

The United States Government has rights in parts of this work pursuant to contract no. DE-AC03-76SF00098 between the United States Department of Energy and the University of California. Some code is derived from software contributed to Berkeley by the Center for Software Science of the University of Utah Computer Science Department. CSS requests users of this software to return to css-dist@cs.utah.edu any improvements that they make and grant CSS redistribution rights.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgement: This product includes software developed by the University of California, Berkeley and its contributors. 4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

University of California, Sun Microsystems, and Scriptics

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., Scriptics Corporation, and other parties. The following terms apply to all files associated with the software unless explicitly disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its documentation for any purpose, provided that existing copyright notices are retained in all copies and that this notice is included verbatim in any distribution. No written agreement, license, or royalty fee is required for any of the authorized uses. Modifications to this software may be copyrighted by their authors and need not follow the
licensing terms described here, provided that the new terms are clearly indicated on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES THEREOF; EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. government, the Government shall have only "Restricted Rights" in the software and related documentation as defined in the Federal Acquisition Regulations (FARs) in Clause 52.227.19 (c) (2). If you are acquiring the software on behalf of the Department of Defense, the software shall be classified as "Commercial Computer Software" and the Government shall have only "Restricted Rights" as defined in Clause 252.227-7013 (c) (1) of FARs. Notwithstanding the foregoing, the authors grant the U.S. Government and others acting in its behalf permission to use and distribute the software in accordance with the terms specified in this license.

University of Washington
Copyright © 1991-1993 University of Washington
Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee to the University of Washington is hereby granted, provided that the above copyright notice appears in all copies and that both the above copyright notice and this permission notice appear in supporting documentation, and that the name of the University of Washington not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. This software is made available "as is", and THE UNIVERSITY OF WASHINGTON DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, WITH REGARD TO THIS SOFTWARE, INCLUDING WITHOUT LIMITATION ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND IN NO EVENT SHALL THE UNIVERSITY OF WASHINGTON BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, TORT (INCLUDING NEGLIGENCE) OR STRICT LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Pine and Pico are trademarks of the University of Washington. No commercial use of these trademarks may be made without prior written permission of the University of Washington.

Paul Vixie
Copyright © 1988,1990,1993,1994 by Paul Vixie. All rights reserved.
Distribute freely, except: don't remove my name from the source or documentation (don't take credit for my work), mark your changes (don't get me blamed for your possible bugs), don't alter or remove this notice. May be sold if buildable source is provided to buyer. No warrantees of any kind, express or implied, is included with this software; use at your own risk, responsibility for damages (if any) to anyone resulting from the use of this software rests entirely with the user.

Larry Wall
Copyright © 1989-1997, Larry Wall. All rights reserved.
This program is free software; you can redistribute it and/or modify it under the terms of either: a) the GNU General Public License as published by the Free Software Foundation; either version 1, or (at your option) any later version, or b) the "Artistic License" which comes with this Perl Kit.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See either the GNU General Public License or the Artistic License for more details.
You should have received a copy of the Artistic License with this Kit, in the file named “Artistic”. If not, I’ll be glad to provide one. You should also have received a copy of the GNU General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

For those of you that choose to use the GNU General Public License, my interpretation of the GNU General Public License is that no Perl script falls under the terms of the GPL unless you explicitly put said script under the terms of the GPL yourself. Furthermore, any object code linked with Perl does not automatically fall under the terms of the GPL, provided such object code only adds definitions of subroutines and variables, and does not otherwise impair the resulting interpreter from executing any standard Perl script. I consider linking in C subroutines in this manner to be the moral equivalent of defining subroutines in the Perl language itself. You may sell such an object file as proprietary provided that you provide or offer to provide the Perl source, as specified by the GNU General Public License. (This is merely an alternate way of specifying input to the program.) You may also sell a binary produced by the dumping of a running Perl script that belongs to you, provided that you provide or offer to provide the Perl source as specified by the GPL. (The fact that a Perl interpreter and your code are in the same binary file is, in this case, a form of mere aggregation.) This is my interpretation of the GPL. If you still have concerns or difficulties understanding my intent, feel free to contact me. Of course, the Artistic License spells all this out for your protection, so you may prefer to use that.